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Introduction to X-Lite

X-Lite is a softphone from CounterPath that enables you to make VoIP voice and video
calls, send and receive instant messages (IMs), and share online status (presence)
information.

X-Lite Features
Standard enterprise telephone features in X-Lite softphone

l Call display

l Voicemail with message waiting indicator (MWI)

l Speakerphone and mute

l Redial

l Hold

l Do not disturb

l Call history

l Three-party audio conferencing (hosted locally)

l Three-party video conferencing (hosted locally)

Enhanced features and functions in X-Lite softphone

l Video calls

l IM and presence using the SIP SIMPLE protocol

l Contact list containing the individual user’s contacts

l Favorites list

l Support for DTMF (RFC 2833, SIP INFO or inband DTMF)

l Automatic detection of audio and video devices

l Acoustic echo cancellation, automatic gain control, voice activity detection

CounterPath Corporation 1

X-Lite User Guide Introduction to X-Lite



l Audio codecs: G.711aLaw, G.711µLaw, G.722, GSM, Opus, , Speex Narrowband,
Speex Wideband

l Video codecs: H.263, H.263+ (1998)

l Compliance with 3261 SIP standard. For SIP and open standards to which X-Lite
is compliant, visit http://www.counterpath.com/sip.html.

l Support for these firewall traversal solutions: STUN, TURN, or ICE

Requirements
Service requirements

l A VoIP service subscription with a local service provider or ISP in order to make
audio or video calls with X-Lite. Please contact your local service provider to
subscribe.

System requirements

Processor Minimum: Core 2 Duo 2.1 GHz
Recommended: i5/i7 2.4 GHz and above

Memory Minimum: 4GB RAM
Recommended: 16 GB RAM and above

Hard Disk Space 400 MB (Install/Upgrade, 200 MB operation)

Operating
System

Microsoft Windows 7 SP1
Microsoft Windows 8.1 (Desktop mode)
Microsoft Windows 10, including 2-in-1 tablet support (Fall Creators Update or newer
required)
macOS 10.12 (Sierra)
macOS 10.13 (High Sierra)
macOS 10.14 (Mojave)

Connection IP network connection (broadband, LAN, wireless); Constant Internet connection

X-Lite supports Windows-based 2-in-1 laptops so you can enjoy using X-Lite in both
desktop mode and tablet mode. Make sure you enable Settings > Devices > Typing >
Touch Keyboard and select Show the touch keyboard when not in tablet mode and
There’s no keyboard attached.
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Quick start – Setting up X-Lite

This section can help you get started with X-Lite.

Set up X-Lite
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Quick start - Getting to know X-Lite
This section can help you get started with X-Lite.

This section can help learn about X-Lite's user interface.

Get to know X-Lite

Learn the tools of X-Lite

Quick start – Handling calls
This section can help you handle calls on X-Lite.

Make and accept calls

Make a call

Enter a phone number or the name of a contact .

Answer a call

Accept with video or audio or hang up to reject the
call.
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Start a conference call

Start a conference

Enter a phone number or
the name of a contact and
select Start Conference

Call.

Add participants

Select additional contacts
to add.

Merge calls together

Click ... More and chooseMerge Calls.
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Getting started

Install and launch X-Lite on your computer.

To launch X-Lite

1. Obtain the X-Lite download file and follow the prompts in the install wizard.

2. Start X-Lite as you would any other program.

X-Lite launches and you are ready to add your SIP account.

Giving permissions to X-Lite (Mac)
On Mac, X-Lite asks permissions for:

l Notifications for incoming calls and messages. See Configuring desktop
notifications.

l Contacts for displaying your contact list within X-Lite

l Microphone for phone conversations

l Camera for video calls

Allow X-Lite a permission if a pop-up appears. Or change permissions by following the
steps below.

To give permissions to X-Lite

1. Click the Apple icon on the X-Lite menu and click System Preferences >
Security and Privacy.

2. Click Privacy.

3. Click Contacts in the list, and select X-Lite to allow access.

4. Repeat Step 3 for Microphone and Camera if applicable.
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Exiting X-Lite
When you are ready to stop using X-Lite, you need to exit X-Lite. If you simply close the
X-Lite on screen phone, X-Lite continues to run in the background.

Exiting X-Lite - Windows

1. Click Exit on the Softphone menu or type CTRL+Q.

Exiting X-Lite - Mac

1. Click Quit X-Lite on the X-Lite menu or type COMMAND+Q.

Setting up your SIP account
A SIP account is used to make voice and video calls in X-Lite. Each user requires a SIP
account. The SIP account can also be used for presence and messaging if your VoIP
service provide supports SIP SIMPLE.

Prerequisites for setting up accounts
The following information is required to set up your SIP account.

SIP account

You need the following information from your VoIP provider to set up your SIP account

l User ID

l Domain

l Password

l Authorization name, if used by your service provider

l Voicemail number, if used by your service provider

You may also require your:

l Firewall traversal method

l Server address
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l Server user name

l Server password (optional)

l Port ranges (optional)

Note: See Transport settings (SIP) for more information.

Setting up a SIP account
You need the following information from your VoIP provider to set up your SIP account:

SIP account requirements

l User ID

l Domain

l Password

l Authorization name, if used by your service provider

l Voicemail number, if used by your service provider

You may also require your:

l Firewall traversal method

l Server address

l Server user name

l Server password (optional)

l Port ranges (optional)

Note: See Transport settings (SIP) for more information.

Setting up your SIP account

You can set up your SIP account when you first launch X-Lite or you can add a SIP
account on a subsequent start up.
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To set up your SIP account on initial start up

1. Click Account Settings.

The SIP Account window opens.

2. In the Account tab, complete the following information:

l Account name: A name that helps you distinguish the SIP account

l User details: The login information provided by your VoIP service provider

l Display name: The name you want to appear in caller ID

3. In the voicemail tab, complete the Number to dial for checking voicemail and the
Number for sending calls to voicemail.

4. Complete the remaining tabs as specified by your service provider or to suit your
setup. Settings that you may need to change immediately are:

l The Proxy Address on the Account panel.

l The Firewall Traversal and Port Ranges on the Topology tab.

5. Click OK.

The SIP account is created. Check Account Settings to make sure that the SIP account
is registered. If the account does not register successfully, review the information you
have added for the account or check with your system administrator or your VoIP service
provider to make sure you have all the correct information.

Your SIP account is ready for voice and video calls.

To set up a SIP account on a subsequent start up – Windows

1. On the Softphone menu, click Account Settings.
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The Account Settings window opens.

2. In the Account tab, complete the following information:

l Account name: A name that helps you distinguish the SIP account

l User details: The login information provided by your VoIP service provider

l Display name: The name you want to appear in caller ID

3. In the voicemail tab, complete the Number to dial for checking voicemail and the
Number for sending calls to voicemail.

4. Complete the remaining tabs as specified by your service provider or to suit your
setup. Settings that you may need to change immediately are:

l The Domain Proxy area on the Account tab.

l The Topology tab if your computer is on a network and / or if you computer is
behind a firewall.

5. Click OK.

The SIP account is created. If the account does not register successfully, review
the information you have added for the account or check with your system
administrator or your VoIP service provider to make sure you have all the correct
information.

Your SIP account is ready for voice and video calls.

To set up a SIP account on a subsequent start up – Mac

1. On the X-Lite menu, click Preferences. Click on the Accounts tab.
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The Account Settings window opens.

2. In the Account tab, complete the following information:

l Account name: A name that helps you distinguish the SIP account

l User details: The login information provided by your VoIP service provider

l Display name: The name you want to appear in caller ID

3. In the voicemail tab, complete the Number to dial for checking voicemail and the
Number for sending calls to voicemail.

4. Complete the remaining tabs as specified by your service provider or to suit your
setup. Settings that you may need to change immediately are:

l The Domain Proxy area on the Account tab.

l The Topology tab if your computer is on a network and / or if you computer is
behind a firewall.

5. Click OK.

The SIP account is created. If the account does not register successfully, review
the information you have added for the account or check with your system
administrator or your VoIP service provider to make sure you have all the correct
information.

Your SIP account is ready for voice and video calls.
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Using the X-Lite interface
You can navigate in X-Lite using the icons on the resource panel and the X-Lite menu.

You can rearrange the order of the icons on the resource panel by dragging and
dropping them into your preferred order.

Windows

The Windows on-screen phone

Compact view
To create the compact view, hide all the resources using the View menu.
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X-Lite menus
The Softphone, View, Contacts, and Help menus are available in the X-Lite menu.

Softphone menu

l Account settings: Account settings apply to individual accounts. These settings
control how you interact with your VoIP service provider. See Configuring X-Lite –
Accounts for more information.

l Preferences: Preferences apply to all accounts. These settings control the way
you work with X-Lite. See Configuring X-Lite – Preferences for more information.

l Sign out: Sign out logs you out of X-Lite and X-Lite displays the log in screen. This
menu item only shows when you select Softphone > Preferences – Application >
Enable Sign In.

l Exit: Use Exit to shut down X-Lite. You can also use CTRL+Q.

View menu

Use the View menu to change how X-Lite looks. In the View menu, you can show or
hide which resources are on the resource panel, open the Messages windows, and view
your Video.

Contacts menu

Use the Contacts menu to add contacts and groups, and to change the way your
contacts are displayed in Contacts and Favorites.

CounterPath Corporation 13

X-Lite User Guide Getting started



Help menu

The Help menu provides support for X-Lite. Use the Help menu to access troubleshoot
problems, check for updates, and upgrade to X-Lite.

Detaching tabs
The Contacts, Favorites, History, and the Directory panels can all be detached from the
on-screen phone into their own window. On the resource panel, click on the tab you
want to detach and then click Detach window. To return the window to the on-screen
phone, click Move back to main window.

Mac
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The Mac on-screen phone

Compact view

To create the compact view, hide all resources on the View menu.

X-Lite menus

The X-Lite menu

The X-Lite menu allows you to set up your accounts and preferences, change the look of
the X-Lite interface, work with contacts, and find support for X-Lite.
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l Preferences: Preferences apply to all accounts. These settings control the way
you work with X-Lite.

l Accounts Settings: Account settings are found in the Preferences menu. Account
settings apply to individual accounts. These settings control how you interact with
your VoIP service provider.

l Quit: Use Quit to shut down X-Lite. You can also use COMMAND+Q.

View menu

Use the View menu to change how X-Lite looks. In the View menu, you can show or
hide which resources are on the resource panel.

Windows menu

Use the Windows menu to Show Messages, Show Video.

Contacts menu

Use the Contacts menu to add contacts and groups, and to change the way your
contacts are displayed in Contacts and Favorites.

Help menu

The Help menu provides support for X-Lite. Use the Help menu to access troubleshoot
problems, check for updates, and upgrade to X-Lite.

Configuring desktop notifications
X-Lite uses OS notifications. Make sure that the notifications are set up in Preferences:
Alerts and sounds panel.

For information on the device that X-Lite uses for ringing, incoming audio, and incoming
video, see Preferences: Devices panel.

To set up notifications on Windows 10

1. From the Start menu, select Settings > System > Notifications & actions.

2. Under Get notifications from these senders, click the entry for X-Lite.
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3. Choose the notification style and preferences.

To set up notifications on a Mac

You can choose banner or alert style notifications. Banner style notifications appear
briefly in the top corner of the screen. Alert styles notifications appear and remain on the
screen until you take action on them.

1. Click the Apple icon on the X-Lite menu and click System Preferences >
Notifications.

2. Click X-Lite.

3. Choose the banner or alert notification style for incoming alerts.

You will receive either a banner or alert notification when you have an incoming call or
instant message on X-Lite.

Checking for X-Lite software updates
Click Check for Updates on the Help menu to see if there is an update available. The
Auto Update (Windows) or the Auto Upgrade (Mac) window opens.

If a new version of the software is available, you can download it from this window. If no
newer version is available, this window informs you that your version is up to date.

Upgrade now…
To use features such as multiple SIP accounts, call forwarding, call recording, call
transfers, and auto-answer, upgrade from X-Lite. Visit Desktop Comparison to see the
full range of features.

Click Upgrade now… on the Help to make a purchase from CounterPath.
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Calls

You can use X-Lite to place and receive audio and video calls, as well as host
conference calls. You can forward, transfer, and record calls.

A user must have a SIP account registered in order to place and receive calls.

In addition to a SIP account, a speaker and a microphone are necessary for audio calls.
For video calls, you also require a video camera to allow the remote parties to see your
image. X-Lite works with most USB video cameras.

You can test your devices in Softphone > Preferences > Devices (Windows) or X-Lite >
Preferences > Devices (Mac). See Preferences: Devices panel for more information.

Placing an audio or video call
You can use X-Lite to place audio and video calls. You can place an audio or video call
from the dialer, from Contacts, Favorites, and Directory (if available), from History, or
from an IM.

Set the default actions for the call button and the double-click button in Softphone >
Preferences (Windows) or Bria > Preferences (Mac).

Using the dialer
Enter a name or phone number in X-Lite's dialer to make a voice or video call from any
tab on the resource panel.

To place a call using the dialer

1. Type the name, phone number, or email of the person you want to call in the Enter
name or number field. As you type, X-Lite may display suggestions for completing
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the entry.

2. Do one of the following:

l Press ENTER after typing the full name, phone number, or email.

l Use the up and down arrow keys on your keyboard to move through the list of
suggestions and press ENTER or TAB to dial.

l Click Make a call or Make a video call after typing the full name,
phone number, or email.

l Select Audio Call or Video Call from the More call options menu after typing
the full name, phone number, or email.

X-Lite makes the call.

Using redial
Redial a number by clicking Make a call or Make a video call without entering a
number or by using the List of recent calls.
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To redial using Make a call or Make a video call

1. Tap Make a call or Make a video call beside Enter name or number.

The last number dialed appears.

2. Do one of the following:

l Tap Make a call or Make a video call a second time.

l Select Audio Call or Video Call from the drop-down menu.

X-Lite makes the call.

To redial using the List of recent calls
X-Lite places an audio call when you use the drop-down list even if the call was a video
call.

1. Tap the List of recent calls drop-down arrow in the Enter name or number field. A
list of recent calls appears.
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2. Click the number or person you want to call.

X-Lite places the audio call.

Using Contacts, Favorites, or Directory
Make calls on X-Lite using the click-to-call button, single-click, double-click, or the short-
cut menu in Contacts, Favorites, or Directory (if available).

To place a call using the click-to-call button

1. Type a name in the Search Contacts, Search Favorites, or Search Directory field
or scroll through Contacts, Favorites, or Directory and find the contact your want to
call. You can also use phone number, or email.

2. Hover on the contact you want to call to reveal the click-to-call button and click
Call this contact.

X-Lite makes the call.

To place a call using the Contact Info flyout

1. Type a name in the Search Contacts, Search Favorites, or Search Directory field
or scroll through Contacts, Favorites, or Directory and find the contact your want to
call. You can also type the email address in Search Contacts.

2. Click on the contact or number you want to call. A Contact Info flyout with the
persons information opens.
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3. Click the number you want to call in the Contact Info flyout.

X-Lite makes the call.

To place a call using the short-cut menu

1. Type a name in the Search Contacts, Search Favorites, or Search Directory field
or scroll through Contacts, Favorites, or Directory and find the contact you want to
call.

2. Right-click (Windows) or CTRL+click (Mac) on the contact you want to call and
click Call or Video Call.

3. If the contact has more than one number, click the number you want to call.

X-Lite makes the call.

To place a call using double-click
Double-click only works if the default action is set to Call. The action for double-click is
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set in Preferences: Application panel.

1. Type a name in the Search Contacts, Search Favorites, or Search Directory field
or scroll through Contacts, Favorites, or Directory and find the contact your want to
call. You can also type the email address in Search Contacts.

2. Double-click the contact or number that you want to call.

X-Lite makes the call.

Note: To use double-click to call, make sure to set Action when double-clicking on contact to
Call in Softphone >Preferences – Application >Default Actions to Call.

Using History
Make calls on X-Lite from History using Make a call, using the short-cut menu, or
using the Contact Info flyout.

Making a call from the Contact Info flyout only works if the person is one of your
Contacts. You may want to use the Contact Info flyout when the person you want to call
is in History but you want to reach them at a different number than the one in History.

To place a call using Make a call

1. Type a name in the Search History or scroll through History and find a grouped
entry with the contact and number you want to call.

2. Click on the group to expand it.

3. Click Make a call.
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X-Lite makes the call.

To make a call using the short-cut menu

1. Type a name in the Search History or scroll through History and find a grouped
entry with the contact and number you want to call.

2. Right-click (Windows) or CTRL+click (Mac) on the History group and click Call or
Video Call.

X-Lite makes the call.

To make a call using the Contact Info flyout

1. Type a name in the Search History or scroll through History and find a grouped
entry with the contact and number you want to call.

2. Click Contact Info.

CounterPath Corporation 24

X-Lite User Guide Calls



3. Click the number on the Contact Info flyout that you want to call.

X-Lite makes the call.

From an instant message
From the Messages windows, call the message sender or call a number in a message.

To call the message sender

1. Select a message from the person you want to call by clicking on the message or
entering the person’s name in the Search Messages field and clicking on the
message.

2. Do one of the following:

l In the menu at the top of the Messages window, tap the Make a call or Make
a video call icon.
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l Click More options for this contact (Windows) or More options for this
conversation (Mac)icon. If the person has more than one phone number,
choose the phone number you want to call.

X-Lite makes the call.

To call a number sent in an IM

1. Click on the number you received in an IM.

X-Lite makes the call.

Changing video options
Video can be added or removed from an established call. If the remote party starts
sending video, your video window opens automatically and their video plays. Your video
is only sent to the remote party if you add it to the call.

To add video to an audio call
1. Click Start sending video (Windows) or Start my video (Mac) at the bottom of

the call panel or on the video window tool bar.
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X-Lite sends your video to the remote party. The remote party may or may not send their
video to you.

To stop and resume video
1. Click the Stop video icon at the bottom of the call panel or the video window to

pause or end your video. You can also close the video windows to stop sending
video. Closing the video window does not end the call.

2. Click Start sending video (Windows) or Start my video (Mac) at the bottom of
the call panel or on the video window toolbar or the open the video window to
resume sending your video.

X-Lite starts or stops sending your video.

To show and hide the video preview
X-Lite can show you a preview of the video you are sending.

1. Click on the video window if it is not in focus and hover over the video window.

2. Click the Toggle local video view icon.
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X-Lite toggles the local video view on and off.

To expand and exit full screen video
1. Click on the video window if it is not in focus and hover over the video window.

2. To view in full screen click the
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Full screen or press F11 (Windows only).

3. To close full screen view click Exit full screen or press ESC (Mac only).

The video window screen changes size.

To change video settings
1. Click the Camera settings icon at the bottom of the video window.

2. Use the drop down menus to change your video device or change your video
resolution.

X-Lite changes the video settings.

Dealing with an auto attendant (Pause dialing)
If you know that your call will be answered by an auto attendant and you know what
menu items you will choose, you can include those menu items (DTMF) in the phone
number when you dial it.

DTMF dialing rules

l Include at least one capital P before the first DTMF number. Each P causes X-Lite
to pause for one second before sending the next character.

l You can include other P’s.

l At the end of the input, include a ; (semi-colon).
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Note: Make sure to enter a ; (semi-colon) when you are done entering pauses and DTMF
numbers or X-Lite will not be able to complete the call.

Examples

Example 1

To dial a number, add a 3-second delay and then press 44, enter this in
the call entry field:

6045551212PPP44;

Example 2

To dial a number, add a 6-second delay, then press 1 then 3 then 2,
each with a two second delay:

6045551212PPPPPP1PP3PP2;

A capital X or a , (comma) can be used instead of P; the following will
work in the same way as the first example above.

6045551212XXX44;

Tip: You can save a number in this format in your contacts.

Placing simultaneous calls
You can make up to two concurrent calls on X-Lite.
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To place a second call

To place a second call, use any of the methods for placing an audio or video call when
you have a call established. X-Lite automatically puts the first call on hold and dials the
second call.

X-Lite displays a call panel for each call.

To swap between calls

Click Take this call off hold on the call you want to switch to. All other calls are put on
hold.

Handling an incoming call
X-Lite must be running to answer incoming calls. It can be running in the system tray. If
X-Lite is not running, incoming calls may be directed to voice mail if you have this
service. Check with your VoIP service provider or your system administrator.

When X-Lite is in the foreground, the call appears in the call panel in the X-Lite interface.
When X-Lite is in the either the foreground or the background, you may also receive a
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notification for the incoming call depending on your settings. To receive notifications on
a Mac, also set the system preferences.

Answering on the call panel
You can answer a call on the call panel or using the notification.

To answer a call on the call panel

1. Click an action button.

One of the following results occurs depending on the action button you choose:

Icon and Meaning - Windows

Answer incoming call: The incoming audio call is answered with audio. If you were
on another call, X-Lite places the first call on hold.

Answer incoming call with audio only: The incoming video call is answered with
audio only. If you were on another call, X-Lite places the first call on hold.

Answer incoming call and start sending my video: The incoming video call is
answered with video. If you were on another call, X-Lite places the first call on hold.

Forward this call to another person without answering: The incoming call is
forwarded without answering it first. A call entry field appears. Enter the name or number
you want to forward the call to and click Forward.

Refuse incoming call: The call is declined and the remote party gets a busy signal or
the call is forwarded to voice mail if you have this service.

Icon and Meaning - Mac

Answer call: The incoming audio call is answered with audio. If you were on another
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call, X-Lite places the first call on hold.

Answer with audio only: The incoming video call is answered with audio only. If you
were on another call, X-Lite places the first call on hold.

Answer with video: The incoming video call is answered with video. If you were on
another call, X-Lite places the first call on hold.

Forward call: The incoming call is forwarded without answering it first. A call entry
field appears. Enter the name or number you want to forward the call to and click
Forward Call.

Reject call: The call is declined and the remote party gets a busy signal or the call is
forwarded to voice mail if you have this service.

Answering notifications
In Windows, you will receive Windows 10 interactive toast notifications or Windows 7
style notifications. In Mac, you will receive banner style notifications or alert style
notifications.

To use Windows interactive toast notifications, you have to enable Use Windows
notifications in Softphone > Preferences > Alerts & Sounds.

To answer Windows 10 interactive toast notifications

1. Click Answer, Decline, or Decline with message in the interactive toast
notification. When you click Decline with message, the message you enter is sent
to the caller as an IM.

To answer Windows 7 style notifications

You can answer a call with the notification by clicking Answer incoming call, Answer
incoming call and start sending my video, or Refuse incoming call.

To answer Mac notifications

Banner style notifications appear briefly in the top corner of the screen. They will
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disappear on their own. To answer a call, click on the notification. This brings X-Lite into
the foreground and you can answer the call using the call panel.

Alert styles notifications appear and remain on the screen until you take action on them.
You can click Answer or Decline on the alert. You can click anywhere else on the
notification to bring X-Lite into the foreground and answer the call using the call panel.

The notifications do not indicate whether the incoming call is an audio call or a video
call. If the incoming call is a video call, X-Lite will answer with video. If you do not want
video, you can stop sending video once the call is established.

Ending a call
To end a one-to-one or conference call, click End call on the bottom of the call panel.
The call panel closes after a few seconds.

To end a video call, click End call on the bottom of the call panel or click End call
in the video window tool bar.

In Windows, you can end a call by right-clicking the X-Lite icon in the taskbar and
clicking End Call.

In Mac, you can end a call by using CONTROL + click on the X-Lite icon in the dock and
click End Call.
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Conference calls

Use X-Lite for three-party audio conferencing (you and two other participants) and three-
party video conferencing (you and two other participants) where you are the host.

With X-Lite, you can create a conference call, remove a participant from a conference
call, send instant messages to conference participants, and place the conference call on
hold.

Creating a conference call
You can create a conference call or you can add participants to an existing call.

Creating a conference call
Create a conference call without an established call.

To create a conference call using the dialer

1. Type a number in Enter name or number.

2. Click More call options beside Make a call or Make a video call and
select Start Conference Call.
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X-Lite connects the first participant.

3. Type a name or a number, use the redial drop-down, or drag a contact into the
Enter name or number field and click Add.

X-Lite creates a three-party conference call.

Adding participants to an established call
You can add a participant to a one-on-one call.

Adding participants to an active call

You can use the More options for handling this call (Windows) or More options
(Mac) from an existing one-on-one call or from an existing conference call.

Using the More menu

1. Click More options for handling this call (Windows) or More options (Mac)
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and click Invite to Conference Call from an established call.

2. Type a name or a number, use the redial drop-down, or drag a contact into Enter
name or number and click Add.

X-Lite creates a conference call.

Merging existing calls

You can create a conference call by merging two or more existing calls.

To add participants by merging calls

1. Establish the two calls you want to merge.

2. On the active call, click More options for handling this call (Windows) or
More options (Mac) and click Merge Calls.
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X-Lite creates a conference call.

Using the short-cut menu in Contacts or Favorites

You can add participants to an established one-on-one call using the short-cut menu in
Contacts or Favorites.

To add participant using the short-cut menu

1. During an established call, go to the Contacts or Favorites panel.

2. Right-click (Windows) or CTRL+click (Mac) on a Contact or Favorite and click Add
to Call.
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X-Lite creates a conference call.

Using the short-cut menu in History

You can add participants to an established one-on-one call using the short-cut menu in
History.

To add participants by using the short-cut menu

1. During an established call, go to the History panel.

2. Right-click (Windows) or CTRL+click (Mac) on a History entry – expanded or
collapsed - and click Add to Call.
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X-Lite creates the conference call.

Video conference calls
To place a video call, a video camera is necessary to allow the remote parties to see
your image. X-Lite works with most USB video cameras.

Including video in a conference call
When you start a conference call from established calls, video is automatically included
if at least one of the established call includes video.

When you create a new conference call, video is not included.

To add video to a conference call

1. Click Start sending video (Windows) or Start my video (Mac).
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Video is sent to all conference participants. Participants can choose whether to share
their own video.

How video is shared
The conference host, the person who started the conference call, serves as the host for
the video feed. The video that the host sees is automatically sent to all participants.

If the conference host pauses or stops the video, the other participants no longer receive
video.

One person does not have video
Participants that have video see Video beside their name. If there are any participants
that do not have video, the host must stop and start the video.

Sending an instant message to a conference
participant
Send individual instant message (IM) to a conference participant.
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To send a participant an instant message (IM)
during the conference call
1. On an established conference call, click Send Instant Message beside the

name of the participant you want to send an IM to. The Messages window opens.

2. Type the message in the Compose Message field.

3. Click Send Message or press ENTER.

X-Lite sends the IM.

Putting a conference on hold
With X-Lite, you can put a conference call on hold.

To put a conference call on hold

1. Click Put conference call on hold at the bottom of the conference call panel.

X-Lite places the conference call on hold.
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To resume a conference call

1. Click Take all participants off hold at the bottom of the conference call panel.

X-Lite takes the conference call off of hold.

Speaking to a participant separately
During a conference call, you can speak to one of the conference participants separately
while maintaining the conference call.

To speak to one participant in a conference call

1. Click Separate Calls beside the participant you want to speak to.

The conference is split into two calls. When you are finished speaking to the separate
participant, you can merge the two calls back into the conference call or end one call
and return to the other call.

Removing a participant or ending a
conference call
You can remove a participant from the conference call and continue with call or you can
end the conference call.
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To end a conference all

1. Click End call from the conference call panel.

X-Lite ends the conference.
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Accessing voice mail

If your service includes voice mail and you have set up voice mail options, you can use
X-Lite to access your VoIP service provider's voice mail services.

When you have a new message, an icon showing the number of messages shows on
Voice messages (Windows) or Voice Mail (Mac) .

To listen to your messages

1. Click Voice messages (Windows) or Voice Mail (Mac).

X-Lite plays your messages.

Multiple SIP accounts
If you have multiple SIP accounts registered, clicking the Voice messages (Windows)
or Voice Mail (Mac) button reveals the number of messages for each SIP account.
Click the account that you want to hear the messages from.

CounterPath Corporation 46

X-Lite User Guide Accessing voice mail



Presence and messaging

You can use X-Lite to share online status using presence and to send instant messages
(IMs).

Presence
X-Lite allows you to share your online status (your presence) with contacts who have a
softphone number. When you launch X-Lite, your online status is Available.

Messaging
Send instant messages to any contact who has a softphone address (if your SIP provider
supports SIP SIMPLE).

You can use emoticons and formatting in your IMs. Use CTRL+B for bold, CTRL+I for
Italic, and CTRL+U for underline on Windows. Use COMMAND+B for bold, COMMAND+I for
Italic, and COMMAND+U for underline for Mac.

By default, SHIFT+ENTER (for Windows) or CONTROL + ENTER (for Mac) inserts a new
line in a message and ENTER sends the message. You can modify this behavior in X-
Lite Preferences.

Changing your status
X-Lite allows you to share your online status (your presence) with contacts who have a
softphone number. When you launch X-Lite, your online status is Available.

You can change your status from Available to Busy, Away, Not available for call, Do not
disturb, and Appear offline. When you change your status from Available, X-Lite no
longer automatically updates your status and it remains as what you set it to until you
change it again.
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X-Lite updates your status to On the phone when you make or receive a phone call if
your status is Available. If you do not use your computer for a specified period of time
(set in Preferences: Application panel), X-Lite updates your status to Idle.

Note: Tomake use of presence on a SIP account, make sure that your VoIP provider supports
SIP SIMPLE.

To change your status

1. Click the drop-down arrow beside your online status indicator.

2. Select the status you want to display.

X-Lite updates your status. If you change your status away from Available, X-Lite does
not automatically update your presence.

Status indicators and what they mean

Icon Status Meaning for your status Meaning for others’
status

Available Either:

l You have set your status to this value.

l X-Lite has determined that you are logged on but not on
the phone or idle.

You can contact this
person.
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When you have this status, X-Lite automatically detects when you
are idle or on the phone, and changes the status to match.

Busy You have set your status to this value. X-Lite never automatically
switches you out of this status; you must switch yourself.

You can contact this
person.

Away You have set your status to this value. X-Lite never automatically
switches you out of this status; you must switch yourself.

You can contact this
person.

On the
phone

Either:

l You have set your status to this value. In this case, X-Lite
never automatically switches you out of this status; you
must switch yourself.

l You started a phone call when your status wasAvailable.
When your call ends, your status reverts back to
Available.

You can contact this
person.

Do not
disturb

You have set your status to this value. X-Lite never automatically
switches you out of this status; you must switch yourself.

You cannot contact
this person.

Not
available
for calls

You have set your status to this value. X-Lite never automatically
switches you out of this status; you must switch yourself.

You cannot contact
this person.

Idle You have not moved or clicked the mouse or pressed a keyboard
key for the idle period. Set the idle period in Preferences:
Application panel.
As soon as you click the mouse or keyboard, your status changes
to Available.

You can contact this
person.

Appear
offline

You have set your status to this value. The other person sees you
as offline, even though you are actually online. The other person
cannot tell the difference between this status and you really being
offline.

The contact is either
not logged on or does
not want to share
online status.

n/a No icon Not applicable You are not watching
the other person’s
status.

Settings your custom status
You can create a custom wording for your presence status. When you set a custom
status, X-Lite does not automatically update your status for you.

To change your custom status

1. Click on the wording in the status indicator and type your custom status. Press
ENTER when you finished.
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X-Lite updates your custom status.

To remove your custom status

1. Click on the wording in the status indicator, delete all text, and press ENTER.

X-Lite returns to the default status wording.

Viewing others’ status
To view the status of one of your contacts, the contact must be tagged for presence.

To view contact status in Contact Profile

If the contact is using SIP for presence, you need to add their SIP address to the
Softphone field. X-Lite automatically obtains the status information for this address.

Online status alerts
You can add and remove contacts, favorites, or group of contacts to the alert list. When a
contact is on the alert list, you receive a X-Lite notification when their online status has
changed.

To add contacts or favorites to the alert list

1. Click on a contact or favorite, or use SHIFT+Click, CTRL+Click (Windows),
COMMAND+Click (Mac) or a combination to select one or more contacts or favorites.

2. Right-click (Windows) or CTRL+click (Mac) and select Add to Alert List (Windows)
or Add Contact to Alert List (Mac).

An alert icon appears by the contact after you add them to the alert list. The icon
disappears when you remove the contact from the alert list.
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To add groups to the alert list

1. Click on a group or use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click
(Mac) or a combination to select one or more groups.

2. Do one of the following:

l Right-click (Windows) or CTRL+click (Mac) and select Add Group to Alert
List (Windows) or Add Contacts in Group to Alert List (Mac).

l Right-click (Windows) or CTRL+click (Mac) and select Remove from Alert
List (Windows) or Remove Contact from Alert List (Mac), Remove Group
from Alert List (Windows) or Remove Contacts in Group from Alert List
(Mac)

An alert icon appears by the contacts in the group after you add them to the alert list. The
icon disappears when you remove the contacts from the alert list.

To remove contacts or favorites from the alert list

1. Click on a contact or favorite, or use SHIFT+Click, CTRL+Click (Windows),
COMMAND+Click (Mac) or a combination to select one or more contacts or favorites.

2. Right-click (Windows) or CTRL+click (Mac) and select Remove from Alert List
(Windows) or Remove Contact from Alert List (Mac).

l Right-click (Windows) or CTRL+click (Mac) and select Add Group to Alert
List (Windows) or Add Contacts in Group to Alert List (Mac).

l Right-click (Windows) or CTRL+click (Mac) and select Remove from Alert
List (Windows) or Remove Contact from Alert List (Mac), Remove Group
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from Alert List (Windows) or Remove Contacts in Group from Alert List
(Mac)

X-Lite removes the contacts or favorites from the alert list. The alert icon disappears from
the contacts.

To remove groups from the alert list

1. Click on a group or use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click
(Mac) or a combination to select one or more groups.

2. Right-click (Windows) or CTRL+click (Mac) and select Remove Group from Alert
List (Windows) or Remove Contacts in Group from Alert List (Mac)

X-Lite removes the groups from the alert list. The alert icon disappears from the contacts.

Alert styles

Windows

You will receive a notification when the contact changes their status. On Windows 7
alerts, select Keep contact on Alert List if you want to continue to see presence changes.
On Windows 10 toast notifications, click Remove Alert to stop seeing presence changes
for the contact. You can call or IM the contact directly from both alert styles.

Mac

Banner style notifications appear briefly in the top corner of the screen. They will
disappear on their own. Alert styles notifications appear and remain on the screen until
you take action on them. Click the notification to bring X-Lite into the foreground.
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Opening the Messages window
There are several ways that you can open the Messages window.

l Click Show the messages window.

l Windows: CTRL+SHIFT+M

l Mac: COMMAND+SHIFT+M

l Windows: Select View > Messages

l Mac: Select Menu > Show Messages

l Click on an IM notification
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Sending an IM
IM's can be sent from the Messages window, the Contacts panel, the Favorites panel, or
from an active call.

Sending an IM from the Messages window
From the Messages window, you can start a new IM or you send another message on an
existing conversation.

To start a new IM

1. In the Messages window, click New Conversation.

2. Type a name into Add recipients. As you type, X-Lite may display suggestions for
completing the entry. Use your mouse or the Up and Down keys to move through
the list of suggestions. Click on the person or press ENTER to select the recipient.

3. Type your message in Compose Message.

4. Click Send Message or press ENTER.
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X-Lite sends the IM.

Add to an existing IM conversation

1. In the Messages window, click on an existing conversation.

2. Type your message in Compose Message.

3. Click Send Message or press ENTER.

X-Lite sends the IM.

Sending an IM from the Contacts or the Favorites panel
From the Contacts or Favorites panel, you can start a new IM using the short-cut menu
or using click-to-message.

To send an using the short-cut menu

1. On the Contacts or Favorites panel, right-click (Windows) or CONTROL+Click
(Mac) on a Contact or a Favorite and select Send Instant Message from the short-
cut menu. If there is more than one IM address, select the one you want to use.
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2. Type your message in Compose Message.

3. Click Send Message or press ENTER.

X-Lite sends the IM.

To send an IM using click-to-message

1. On the Contacts or Favorites panel, hover on the contact you want to message to
reveal the click-to-message button. Click Instant message this person.

2. Type your message in Compose Message.

3. Click Send Message or press ENTER.

X-Lite sends the IM.

Sending an IM from an active call
From an active call, you can send a message using More options for handling this call.
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To send an IM from an active call

1. During an active call, click More options for handling this call (Windows) or
More options (Mac) in the call panel and click Send Instant Message.

2. Type your message in Compose Message.

3. Click Send Message or press ENTER.

X-Lite sends the IM.

Receiving an IM
When you receive an IM, the Messages window or a notification appears. To control the
type of notification, go to Softphone > Preferences > Alerts & Sounds (Windows) or X-
Lite > Preferences > Alerts (Mac).

Windows 10 interactive toast notification
You can type your response directly into a Windows 10 interactive toast notification or
you can click on the notification to open it in the Messages window.

Windows 7 and Mac notifications
You click on the Windows 7 or a Mac IM notification to open it in the Messages window.
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Deleting messages
You can delete an IM conversation from X-Lite. Before you delete a conversation, you
may want to export it.

To delete a conversation using Delete Conversation

1. Click Delete Conversation beside the session.

A Delete Conversation dialog opens.

2. Click Yes (Windows) or OK (Mac).

X-Lite deletes the session.

To delete a conversation using the More menu

1. Click on the session, click More options for this contact (Windows) or More
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options for this conversation (Mac) and click Delete Conversation.

A Delete Conversation dialog opens.

2. Click Yes (Windows) or OK (Mac).

X-Lite deletes the session.

To delete a conversation using the short-cut menu – Windows only

1. Right-click on the session and click Delete Conversation.

A Delete Conversation dialog opens.

2. Click Yes (Windows) or OK (Mac).
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X-Lite deletes the session.

Tip: If you selectDon’t show this warning again before clicking Yes on theDelete
Conversation dialog, you will not receive a warning before deleting sessions in the future.

Working with messages
X-Lite allows you to preview, search, copy/paste, export, and delete messages and
conversations.

Previewing hyperlinks
When you send or receive a message with a hyperlink in it, X-Lite can show a preview of
the hyperlink in the message.

To control hyperlink previews

1. Click Preferences on the Softphone menu (Windows) or the X-Lite menu (Mac).

2. Select or clear Show hyperlink preview on messages.

X-Lite either shows or removes previews for all the hyperlinks in Messages.

Search messages
You can use the search feature to find a message using a name or a keyword.

To search in messages

Search your messages with a name or a keyword.
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1. Type the contacts name or search keywords in the Search Messages field. X-Lite
filters the sessions that contain the search words.

2. Click the message you want to view.

The session appears in the Messages pane.

Copying and pasting messages
You can copy messages from X-Lite and paste within the X-Lite or in another
application.

To copy and paste messages

1. In the Messages window, highlight the message or messages that you want to
copy.

2. Do one of the following:

l Windows: Right-click one of the selected messages and click Copy.

l Mac: COMMAND+Click on one of the selected messages and click Copy.
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l Windows: Press CTRL+C on the keyboard.

l Mac: Press COMMAND+C on the keyboard.

X-Lite places the messages on the clipboard. You can paste the messages in X-Lite or
in another app on your computer.

To export a conversation

You can export a conversation into a CSV file.

1. Click on a session Do one of the following:

l Click on the session, More options for this contact (Windows) or More
options for this conversation (Mac), and then click Export Conversation.

l Windows: Right-click on the session and click Export Conversation.

X-Lite opens the File Manager.

2. Select the location and enter a name for the file. Click Save.

X-Lite saves the session as a .csv file in the location you selected.
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Contacts

Contacts are organized in groups in List of contacts (Windows) or Contacts (Mac) —
referred to as Contacts. The Contacts tab is empty at start-up. Each contact is shown
with presence information (if available) and icons for single-click calling and messaging.

If you have contacts that you use frequently, you can add these contacts as Favorites for
easier access.

If the Contacts or Favorites tabs are not showing, click Show Contacts or Show
Favorites on the View menu.

Viewing contacts
You can view a contact from the Contacts, Favorites or History tab.

Using Contacts and Favorites
In Contacts or Favorites, you can open the Contact Info flyout, or open the Contact
Profile (Windows) or the Contact Editor (Mac) for more contact details.

Using the Contact Info flyout

1. Click on a contact in Contacts or Favorites. A Contact Info flyout appears with
contact information.

2. Click Profile if you want to see more information.
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X-Lite displays the Contact Profile (Windows) or the Contact Editor (Mac).

Using the short-cut menu

1. Right-click (Windows) or CTRL+click (Mac) on a contact in Contacts or Favorites
and select Edit Profile (Windows) or View/Edit Profile (Mac).

X-Lite displays the Contact Profile.

Using History
In History, you can open the Contact Info flyout, or open the Contact Profile (Windows)
or the Contact Editor (Mac) for more contact details.

Using the Contact Info flyout

1. Click on a History group to expand the group entry.
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2. Click on Contact Info. A Contact Info flyout appears with contact information.

3. Click Profile if you want to see more information.

X-Lite displays the Contact Profile (Windows) or the Contact Editor (Mac).

Using the short-cut menu

1. Right-click (Windows) or CTRL+click (Mac) on a call group or the heading of an
expanded call group.

2. Click Edit Contact.

X-Lite displays the Contact Profile (Windows) or the Contact Editor (Mac).
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Adding and exporting contacts
For each contact you communicate with, you can save their information as an entry in
the contacts list. These contacts are added individually. You can also export your
contacts to a .csv file, a vCard file, or a .pst file.

Adding an individual contact
You can add contacts individually in the Contacts panel, using the Contacts menu and
in the History panel.

Adding a contact in the Contacts panel

Use Add a new contact or the short-cut menu to add an individual contact from the
Contacts panel.

To add a contact using Add a new contact

1. On the Contacts panel, click Add a new contact.

The Contact Profile (Windows) or the Contact Editor (Mac) window appears.

2. Use the Group drop-down arrow to select the group or groups that you want a
contact to belong to.
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3. Use the drop down list to select the type of information you want to add, type the
information, and click Add (Windows) or the Add number icon (Mac).

When you use the Instant Message contact method, a window will open to send
an introduction to the contact. Type an introduction, if desired. If you do not want to
see the presence status for this person, clear Enable presence. When you are
finished click Continue.

4. Complete the Display name (required on Windows).

5. Complete any other fields you want to include with the contact.

6. Click OK.

The contact is added to the X-Lite.

To add a contact using the short-cut menu

1. right-click (Windows) or CONTROL+Click (Mac) on a group and click Add Contact

CounterPath Corporation 67

X-Lite User Guide Contacts



to Group. The Contact Profile (Windows) or the Contact Editor (Mac) window
opens.

2. Use the drop down list to select the type of information you want to add, type the
information, and click Add (Windows) or the Add number icon (Mac).

When you use the Instant Message contact method, a window will open to send
an introduction to the contact. Type an introduction, if desired. If you do not want to
see the presence status for this person, clear Enable presence. When you are
finished click Continue.

3. Complete the Display name (required on Windows).

4. Complete any other fields you want to include with the contact.

5. Click OK.

The contact is added to the X-Lite.
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Adding a contact using the Contacts menu

You can add contacts to X-Lite using the Contacts menu on the menu bar.

To add a contact using the Contacts menu

1. Click Add Contact on the Contacts menu.

2. Use the Group drop-down arrow to select the group or groups that you want a
contact to belong to.

When you use the Instant Message contact method, a window will open to send
an introduction to the contact. Type an introduction, if desired. If you do not want to
see the presence status for this person, clear Enable presence. When you are
finished click Continue.

3. Complete the Display name (required on Windows).

4. Complete any other fields you want to include with the contact.

5. Click OK.

The contact is added to the X-Lite.

CounterPath Corporation 69

X-Lite User Guide Contacts



Adding a contact in the History panel

Add an unknown caller to Contacts from History using Add this person to your
contact list or using the short-cut menu.

To add a contact Add this person to your contact list

1. Click on a History group with the caller ID Unknown. The History group expands.

2. Click Add this person to your contact list. The Contact Profile (Windows) or
the Contact Editor (Mac) opens.

3. Use the Group drop-down arrow to select the group or groups that you want a
contact to belong to.

4. Use the drop down list to select the type of information you want to add, type the
information, and click Add (Windows) or the Add number icon (Mac).
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When you use the Instant Message contact method, a window will open to send
an introduction to the contact. Type an introduction, if desired. If you do not want to
see the presence status for this person, clear Enable presence. When you are
finished click Continue.

5. Complete the Display name (required on Windows) and any other fields you want
to include with the contact.

6. Click OK.

The contact is added to the X-Lite.

To add a contact using the short-cut menu

1. Right-click (Windows) or CTRL+click (Mac) on the History entry with the caller ID
Unknown. and click Add to Contacts.

The Contact Profile (Windows) or the Contact Editor (Mac) opens.

2. Use the Group drop-down arrow to select the group or groups that you want a
contact to belong to.
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3. Use the drop down list to select the type of information you want to add, type the
information, and click Add (Windows) or the Add number icon (Mac).

When you use the Instant Message contact method, a window will open to send
an introduction to the contact. Type an introduction, if desired. If you do not want to
see the presence status for this person, clear Enable presence. When you are
finished click Continue.

4. Complete the Display name(required on Windows) and any other fields you want
to include with the contact.

5. Click OK.

The contact is added to the X-Lite.
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Fields in Contact Profile

The Contact Profile is divided into Contact Summary, Contact.If you have merged
multiple contacts together, you may see more than one Contact section.

Some fields may be read-only depending on how the contact was added to X-Lite.

This following is a list of X-Lite contact fields and their description:

Contact summary

l Contact image: The image associated with the contact. If the contact has more
than one image, use the drop-down to choose the image that you want to use. You
can also use the drop-down to Change or Reset the image.

l Group: Click the drop-down list and select each group the contact is going to
belong to. A contact must belong to one group and can belong to multiple groups.
See Managing groups for more information.

l Primary presence: This field is read-only. Primary presence is used for:

l The presence icon on the contact list that shows the status for this address.

l The single-click and double-click actions for instant messaging.

You can still send IMs to this person at their other addresses by using right-click
(Windows) or CONTROL+Click (Mac) and choosing them from the short-cut menu.

l Primary Call (Mac): This field is read-only unless the contact has more than one
phone number. Primary Call is used with single-click calling and double-click
calling.

l Primary phone number (Windows): This field is ready-only unless the contact has
more than one phone number. The Primary phone number is used with single-
click calling and double-click calling.

Contact

Display name (required on Windows): The display name is the source of
information.

First name, Last name (Optional): A first name and a last name for the
contact.
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Contact Methods: The drop-down list that contains the different methods of
contacts.

Choose Softphone if you are using your SIP account for messaging and
presence.

Presence: This field is automatically populated when you enter and address
in the Softphone contact method. It indicates that you are sharing presence
information using this address. The address is shown in the list in the
Primary presence field.

Exporting contacts
You can export X-Lite contacts to a file on your computer.

Windows

In Windows, X-Lite contacts can be exported as a .csv file, a vCard file, or a .pst file.

To export a .csv file

1. On the Contacts menu, click Export Contacts.

2. Select Comma-separated value (*.csv file) from the drop-down list and click Next.

3. Click Browse.

The Windows save dialog open.

4. Use the file explorer to find the location you want to save the file, give the file a
name and click Save.
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5. Click Next on Export Contacts.

A new .csv file is created in the location you chose in the Export Contacts wizard.

l PST: For a PST export, the existing PST file is updated to include the entries from
X-Lite. If Microsoft® Outlook® is open, the entries immediately appear in the
Outlook contacts.

All information in X-Lite is exported to Microsoft Outlook. Only information that can
be displayed in Outlook appears in the Outlook Contacts window. Typically, this
means that all softphone addresses are exported (and stored in custom fields) but
not displayed in Outlook.

l vCard and CSV: A new file of the specified type is created in the location you
chose in the Export Contacts wizard.

To export a .vCard file

1. On the Contacts menu, click Export Contacts.

2. Select vCard (*.vcf file) from the drop-down list and click Next.

3. Click Browse. The Browse For Folder dialog opens.

4. Use Browse For Folder to navigate to the location you want to save the file and
click OK.

5. Click Next on Export Contacts.

A new vCard file is created in the location you chose in the Export Contacts wizard.
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To export a .pst file

1. On the Contacts menu, click Export Contacts.

2. Select Outlook or Exchange server from the drop-down list and click Next.

3. Click Browse.

The Windows save dialog open.

4. Use the file explorer to find the location you want to save the file, give the file a
name and click Save.

5. Use the drop down list to select a field to use in the .pst file for the softphone
address and the IM address.

6. Click Next.

The existing PST file is updated to include the entries from X-Lite. If Microsoft® Outlook®

is open, the entries immediately appear in the Outlook contacts. Typically, this means
that all softphone addresses are exported (and stored in custom fields) but not displayed
in Outlook.

Mac

In Mac, X-Lite contacts can be exported as a .csv file or a vCard file.
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To export a .csv file

1. On the Contacts menu, click Export Contacts.

2. Select Comma separated values (*.csv file) from the drop-down list.

3. Type a name for the file in Save as.

4. Use Browse to select the location you want to export the file to.

5. Click Export.

A new file of the specified type is created in the location you chose in the Export
Contacts wizard.

To export a vCard file

1. On the Contacts menu, click Export Contacts.

2. Select vCard (*.vcf file) from the drop-down list.

3. Use Browse to select the location you want to export the file to.

4. Click Export.

A new file of the specified type is created in the location you chose in the Export
Contacts wizard.

Editing a contact
You can update contact information, change the contact groups, and delete contacts.
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Updating contact information
You can open the Contact Profile (Windows) or the Contact Editor (Mac) from Contacts,
Favorites, or History. Once in the Contact Profile (Windows) or the Contact Editor
(Mac), you can edit the contact.

Using Contacts and Favorites

In Contacts and Favorites, you can use the Contact Info flyout or the short-cut menu to
open the Contact Profile (Windows) or the Contact Editor (Mac) so you can edit
contacts.

To edit a contact using the Contact Info flyout

1. Click on a contact and click Profile in the Contact Info flyout.

The Contact Profile (Windows) or the Contact Editor (Mac) window opens.

2. Edit any of the fields that need to be changed.

3. Click OK.

The contact is updated in X-Lite. If you add or edit the Softphone contact method, an
online status request is sent to this person.
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To edit a contact using the short-cut menu

1. Right-click (Windows) or CTRL+click (Mac) on a contact and select Edit Profile
(Windows) or View/Edit Profile (Mac).

The Contact Profile (Windows) or the Contact Editor (Mac) window opens.

2. Edit any of the fields that need to be changed.

3. Click OK.

The contact is updated in X-Lite. If you add or edit the Softphone contact method, an
online status request is sent to this person.
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Using History

In History, you can use the Contact Info flyout or the short-cut menu to open the Contact
Profile (Windows) or the Contact Editor (Mac) so you can edit contacts.

To edit a contact using the Contact Info flyout

1. Click on a History group to expand the group entry.

2. Click on Contact Info. A Contact Info flyout appears with contact information.

3. Click Profile.

The Contact Profile (Windows) or the Contact Editor (Mac) window opens.
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4. Edit any of the fields that need to be changed.

5. Click OK.

The contact is updated in X-Lite. If you add or edit the Softphone contact method, an
online status request is sent to this person.

To edit a contact using the short-cut menu

1. Right-click (Windows) or CTRL+click (Mac) on a call group or the heading of an
expanded call group.

2. Click Edit Contact.

The Contact Profile (Windows) or the Contact Editor (Mac) window opens.

3. Edit any of the fields that need to be changed.

4. Click OK.

The contact is updated in X-Lite. If you add or edit the Softphone contact method, an
online status request is sent to this person.
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Changing contact groups
You can move a contact from one group to another or add them to multiple groups.

To move contacts to another group

1. In the contacts panel, use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click
(Mac) or a combination to select one or more contacts you want to move to another
group.

2. Drag the selected contacts to the title bar of the new group.

The contact or contacts are removed from the old group and added to the new group.

To add and remove contacts from multiple groups using the Contact Profile

1. Right-click (Windows) or CTRL+click (Mac) on a contact and select Edit Profile
(Windows) or View/Edit Profile (Mac).
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The Contact Profile (Windows) or the Contact Editor (Mac) window opens.

2. Click the drop-down arrow in Group. Select the groups you want to add the contact
to and deselect the groups you want to remove the contact from.

3. Click OK.

The contact is added to all groups you selected and removed from all groups you
deselected.

To remove a contact from a single group

If a contact is in multiple groups, you can remove them from one of the groups.

1. Use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click (Mac) or a
combination to select one or more contacts you want to remove from a group. Make
sure you select the contact or contacts in the group you want to delete them from.

2. Right-click (Windows) or CTRL+click (Mac) and click Delete Contact for an
individual contact or Delete Selected for multiple contacts.
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3. If the contact belongs to more than one group, clear Delete this contact from all
groups or Delete these contacts from all groups. Click Yes in the Delete Contact
dialog.

The contact or contacts are removed from the group. They remain in any other groups
they belonged to.

Deleting a contact
You can delete a single contact or a group of contacts from X-Lite.

To delete one or more contacts

1. In the contact panel, use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click
(Mac), or any combination to select the contacts you want to delete.

2. Right-click (Windows) or CTRL+click (Mac) and select Delete Contact or Delete
Selected.
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3. If the contact belongs to more than one group, leave Delete this contact from all
groups or Delete these contacts from all groups selected. Click Yes.

The contacts are deleted.

Managing groups
Contacts are arranged in groups. X-Lite has three default groups: Family, Friends, and
Work.

Each contact must belong to at least one group and can belong to multiple groups. You
can create, rename, and delete groups.

As well as organizing your contacts, you can perform the following actions on groups
instead of on individual contacts:
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Add a group to Favorites

Creating a group
Use the short-cut menu or the Contacts menu to create a new group.

To create a new group using the short-cut menu

1. Right-click (Windows) or CTRL+click (Mac) on a group in contacts from the short-
cut menu.

2. Type in a group name in the New Group window and click OK.

The new Group is displayed in the List of contacts.

To create a new group using the Contacts menu

1. Click New Group on the Contacts menu.

CounterPath Corporation 86

X-Lite User Guide Contacts



2. Type in a group name in the New Group window and click OK.

The new Group is displayed in Contacts.

Renaming a group

To rename a group using the short-cut menu

1. Right-click on a group in Contacts and select Rename Group.

2. Type in a the new group name in the Rename Group window and click OK.
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The Group appears with the new name in the List of contacts.

Deleting groups

To delete a group

1. Right-click (Windows) or CTRL+click (Mac) on a group in contacts and select
Delete Group.

2. If there are contacts in the group, click Yes in Delete Group.

The Group is deleted from contacts. Any contacts that were not in another group are
deleted.
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Favorites
You can create favorites from the Contacts panel or in the contact profile. When you add
a contact to Favorites, it displays in both the Contacts panel and the Favorites panel.

Adding a contact to Favorites
You can add a contact to Favorites using the short-cut menu.

To add a contact to Favorites

1. Click on a contact, SHIFT+Click, CTRL+Click (Windows), COMMAND+Click (Mac)
one or more contacts you want to add to Favorites.

2. Right-click (Windows) or CTRL+click (Mac) and select Add to Favorites.

The contact or contacts are added to Favorites.

Adding a group to Favorites
You can add a group to Favorites using the short-cut menu.

To add a group to Favorites

1. Click on a contact, SHIFT+Click, CTRL+Click (Windows), COMMAND+Click (Mac)
one or more contacts you want to add to Favorites.

2. Right-click (Windows) or CTRL+click (Mac) and select Add Group to Favorites
(Windows) or Add Contacts in Group to Favorites (Mac).
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The contacts in the group or groups appears are added to Favorites and can be viewed
in the Favorites panel.

Removing a contact from Favorites
You can remove a contact from Favorites panel using the short-cut menu.

To remove a contact from Favorites

1. On the Favorites panel, click on a contact, or SHIFT+Click, CTRL+Click
(Windows), COMMAND+Click (Mac) one or more contacts you want to remove from
favorites.

2. Right-click (Windows) or CTRL+click (Mac) and select Remove from Favorites.

The contact or contacts are removed from the Favorites panel but still appear in the
Contacts panel.

Warning: If you selectDelete Contact, the contact is deleted from X-Lite, not just from
Favorites.
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History

All X-Lite calls are captured in the X-Lite's List of recent calls (Windows) or History
(Mac) – referred to as History. The last 200 records are stored in X-Lite and grouped by
phone number.

Viewing History
All X-Lite calls are captured in X-Lite's List of recent calls (Windows) or History (Mac) –
referred to as History. Calls are grouped to easily find all calls from one contact, and can
be filtered to make it easier to find a specific call.

Call grouping
Calls captured in X-Lite's history are grouped by name and caller ID. The caller ID can
be a phone number or a SIP address, but will be referred to as phone number. The
group can be expanded and collapsed to show or hide the individual calls received.

If a person has called you from multiple numbers, you may see more than one group of
calls for them.

Collapsed group display

The collapsed group displays an overview of call information: the name and presence
status of the caller, the number and types of calls, and the time and date of the most
recent call.

Expanded group display

The expanded group shows a list of recent calls between you and the person. The most
recent calls are displayed at the top of the list. In addition to the information displayed in
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the collapsed group, X-Lite also shows whether the call was voice or video, and the
length or the call.

Multiple groups for the same number

In some cases, calls from the same person may show up in multiple groups. If one call
only contains the phone number, and another call contains the phone number a domain,
they calls appear in two different groups. X-Lite does not strip the domain and try to
match the results with other calls.

Multiple contacts with the same number

When you have a number that is used for multiple contacts, all calls for that number are
grouped together as Multiple Contacts. Expand the group and click Contact Info to
see the contacts associated with the number.

Unknown contacts

There are two types of unknown contacts that can appear in the call history. If a call
comes from a phone number that is not in your contacts, the contact is grouped as
Unknown with the phone number displayed. Calls that come in with an unknown number
are grouped as Unknown with Unknown displayed for the number.
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To view all calls in a group

1. Click the group you want to expand.

X-Lite displays the expanded group.

Call type icons and their meanings
Incoming call

Outgoing call

Missed call

Filtering call history
Limit the calls you see in the call history using filtering. X-Lite lets you filter all calls,
missed calls, and calls by date.

Filtering for missed calls

You can filter call history for all missed calls or filter for missed calls on a specific
account if you have more than one account.

To filter missed calls

1. Click on the call filter and click Missed Calls.
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2. Click All or click the account you want to see missed calls from if you have more
than one SIP account.

X-Lite displays all missed calls or the missed calls for the selected account.

You can filter which calls you see in X-Lite's History.

Filtering by date

You can search X-Lite for calls based on when the call occurred. Filter calls from Today,
Yesterday, This Week, This Month, Last 7 Days, and Last 30 Days. This Week filters for
calls for the current week running from Sunday to Saturday. This Month filters for calls
during the current calendar month.

To filter by date

1. Click on the call filter and click Date.
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2. Click the selector for the dates you want to filter.

X-Lite displays all calls that match the date selector.

To see which filter is applied to call history when the full name of the
filter does not fit, hover over the filter drop down and the full text
appears.

Searching and filtering History
To find a specific entry in History, you can filter or search the list of recent calls, or use
both methods.

CounterPath Corporation 95

X-Lite User Guide History



Limit the calls you see in the call history using filtering. X-Lite lets you filter all calls,
missed calls, and calls by date.

Searching History
Search for a call in History by either the name of the caller or by their phone number.

To search History

1. Type the name or phone number for the call your are looking for in Search History.

2. Expand the History entry to find specific call details.

X-Lite displays all calls from the name or number.

Filtering History
Limit the calls you see in History using filtering. X-Lite lets you filter all calls, missed
calls, and calls by date.

Filtering for missed calls

You can filter History for all missed calls.
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To filter missed calls

1. Click on the call filter and click Missed Calls.

X-Lite displays all missed calls.

Filtering by date

You can search X-Lite for calls based on when the call occurred. Filter calls from Today,
Yesterday, This Week, This Month, Last 7 Days, and Last 30 Days. This Week filters for
calls for the current week running from Sunday to Saturday. This Month filters for calls
during the current calendar month.

To filter by date

1. Click on the call filter and click Date.

2. Click the selector for the dates you want to filter.
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X-Lite displays all calls that match the date selector.

To see which filter is applied to call history when the full name of the
filter does not fit, hover over the filter drop down and the full text
appears.

Search and filter History
Use search and filter at the same time. You can filter your results first, and then enter
your search information or enter your search information first and filter your results.

Deleting History
Calls are grouped by caller ID in X-Lite's List of recent calls (Windows) or History (Mac)
– referred to as History. You can delete all calls in History, or you can delete all calls in a
group.
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To delete all calls

1. Right-click (Windows) or CTRL+click (Mac) on a call group or the heading of an
expanded call group.

2. Click Delete All.

3. Click OK on Confirm Delete.

X-Lite deletes all calls from History.

To delete a History group

1. Right-click (Windows) or CTRL+click (Mac) on the call group or the heading of the
expanded call group you want to delete.

2. Click Delete.

X-Lite deletes the calls in the History group.
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Warning: There is no warning before all calls in a group are deleted.
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Configuring X-Lite

This section describes how to set up accounts and preferences on X-Lite.

Configuring X-Lite – Accounts
There are two ways of configuring X-Lite – Account Settings and Preferences.

Account Settings are settings that only apply to an individual account. Preferences are
settings that apply to X-Lite as a whole.

To view the Account Settings

Windows

1. Click Account Settings on the Softphone menu.

The Account Settings window opens.

Mac

1. Click Preferences on the X-Lite menu.

2. Click Accounts.

The Preferences – Accounts window opens.
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The Call column

The Call column shows how the account is used for calls.

Windows iconsIcons

: The account is the preferred account for calls

: The account can be used for outgoing calls if you select is when placing an outgoing
call

no icon: The account cannot be used for phone calls. It is either a SIP account with
calling disabled or a non-SIP account.

Mac iconsIcons

: The account is the preferred account for calls

: The account can be used for outgoing calls if you select is when placing an outgoing
call

: The account cannot be used for phone calls. It is either a SIP account with calling
disabled or a non-SIP account.

The Status column

The Status column indicates the registration status of each account.

Windows

Ready: The account is registered and can be used for calls (SIP) and messaging.

Registering: The account is in the process of registering.

Failed: The account is enabled but registration failed. Check that you entered your
account credentials correctly.

Disabled: The account is disabled. Select the Enabled check box to register the account.

MacMeaning

: The account is registered and can be used for calls (SIP) and messaging.

: The account is in the process of registering.
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: The account is enabled but registration failed. Check that you entered your account
credentials correctly.

: The account is disabled. Select the Enabled check box to register the account.

SIP account
A SIP account is used to make voice and video calls in X-Lite. Each user requires a SIP
account. The SIP account can also be used for presence and messaging if your VoIP
service provide supports SIP SIMPLE.

This section describes the SIP account settings. See Setting up a SIP account to see
how to set up your SIP account.

Account or General panel (SIP)

The Accounts (Windows) or General (Mac) panel lets you configure User Details,
Domain Proxy, and the Dial plan for the account.

User ID and Domain are required fields.

Settings in this panel

Account Name

Account Name: Used to identify the account. If desired, change the name to something
meaningful to you. For example, the name of your VoIP service provider.

Protocol: Read-only. Always specifies SIP.

Allow this account for

Calls (Windows) / Used for Call (Mac): Determines if the account is used to place
outbound calls.

Selected: This account can be used for outbound calls.

Cleared: This account cannot be used for outbound calls.

IM / Presence (Windows) / Presence (Mac): Determines if the account is used for
presence and messaging. Make sure SIP SIMPLE is supported by your VoIP service
provided is you plan to use your SIP account for presence and messaging.
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Selected: This account is used to share your online presence and send
instant messages.

Cleared: This account is not used to share your online presence and send
instant messages.

User Details

User ID: The account number for the softphone. Provided by your VoIP service provider.

Domain: The domain of your softphone address. Provided by your VoIP server provider.

Password: The password for the softphone. Provided by your VoIP service provider.

Display name: This is the name that is displayed in the X-Lite title bar. Remote parties
see this name.

Authorization name: Complete this field if your VoIP service provider gave you an
authorization name. Typically not used in an enterprise environment. An Authorization
name is useful if you allow user IDs that are short and easy to guess. The Authorization
name is used in place of the User ID to register the SIP account.

Domain Proxy

Register with domain and receive calls: This field must be Cleared if your level of
service does not include the ability to receive incoming calls. In this case, leaving this
field selected may prevent the account from registering.

Selected: Register this account with your VoIP service provider so you can
receive incoming calls.

Cleared: This SIP account cannot be used for incoming calls.

Send outbound via: Choose the settings specified by your VoIP service provider. If you
select this field, complete the Address field with the domain provided by your VoIP
service provider.

Domain: Select this field if your VoIP service provider requires that traffic be
directed to proxies that are discovered via the domain.

Proxy: Select this field if your VoIP service provider has an outbound proxy
address and requires that you provide the address to your softphone client.
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If neither of these options are suitable, see Advanced for additional ways to direct traffic.

Dial Plan

Dial Plan: Information about the syntax of the numbers used by your VoIP service
provider. This information is provided by your VoIP service provider.

The default plan is: #1\a\a.T;match=1;prestrip=2;

You do not have to change the dial plan if:

l You only have one SIP account.

l You have multiple SIP accounts but will always manually select the account to use
for calls.

l The default plan is acceptable.

See Using a Dial Plan to Modify How Calls are Placed for information on configuring
dial plans.

Voicemail panel (SIP)

This panel lets you set up client-side voicemail.

Voicemail is offered through your VoIP service provider or through your enterprise’s IP
PBX. It is not part of X-Lite. Contact your VoIP service provider or your system
administrator for information on using voicemail.

Settings in this panel:

Voicemail

Check for voicemail: Check with your VoIP service provider or your enterprise’s IP PBX
system administrator for the correct configuration.

Selected: Subscribe for message waiting — X-Lite must subscribe to be
notified when there is a voicemail.

Cleared: Implicit subscription — the VoIP service provider’s voicemail server
send notifications without X-Lite subscribing.

Cleared: Your VoIP service provider does not support voicemail.
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Number to dial for checking voicemail: Complete this field only if your VoIP service
includes voicemail. This is the number that will be called when a user click the Voice
messages icon on X-Lite to check for voicemail and listen to messages. Completing this
field enables the Voice messages icon. If you leave this field empty, the icon will not
work and you will have to dial your voicemail number manually. Enter the number
provided by your VoIP service provider or system administrator.

Number for sending calls to voicemail: Complete this field only if your VoIP service
includes voicemail. This is the number that incoming calls will be forwarded to if they are
unanswered after the specified interval. This field must be completed if you select Send
call to voicemail if unanswered for. If you leave this field empty, X-Lite never forwards
call to your service provider’s voicemail. However, most VoIP service providers have
their own mechanism for sending unanswered calls to voicemail. Leaving this field blank
does not mean that forward-to-voicemail does not work. Enter the number provided by
your VoIP service provider or your system administrator.

Send calls to voicemail if unanswered for: Complete this field only if your VoIP service
includes voicemail. Your service provider may have a similar feature outside X-Lite. If
they do, make sure that you are not entering competing information in X-Lite and in the
service provider’s interface. For example, if you clear this field in X-Lite, make sure that
you turn this feature off with your service provider as well or calls continue to be
forwarded.

Selected: X-Lite sends call to voicemail when the specified interval expires.
Enter the time interval in seconds.

If you have a subscription from a VoIP service provider

Your VoIP service provider may provide the ability to set up voicemail outside of X-Lite
(server-side handling), such as calling a softphone address and following voice prompts
or by accessing a website.

Check with your VoIP service provider to determine if another setup mechanism is
available. If so, check what settings are in the setup and make sure you enter the
compatible information in X-Lite.

If you have a System Administrator managing IP PBX

Your IP PBX may also provide the ability to configure voicemail outside of X-Lite (server-
side handling). An incoming phone call first goes through server-side handlers and then
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through client-side handlers. Keep in mind that the fields on the Voicemail tab are not
written to the server. They are configuring a second, separate handler.

Decide how you want phone calls to be handled — by the X-Lite client only, by the server
only, or by both the client and the server. Instruct your users accordingly. If you decide to
allow both, make sure that your users understand how the server-side and the client-side
voicemail configuration must be synchronized to work together. Check what the server-
side settings are and make sure you enter compatible information on X-Lite.

Topology panel (SIP)

This panel controls how signals are passed through your network.

Settings in the panel:

Firewall Traversal

Firewall traversal method: Choose the settings recommended by your VoIP service
provider.

Auto-detect firewall traversal method using ICE (Windows) / Auto-detect
(ICE, recommended) (Mac): Automatically determines the contact address
for signaling traffic.

Discover public IP address (STUN): Advertises the public IP address
(discovered via STUN) for the contact address for signaling traffic and for the
connection address for media traffic.

Use media relay (TURN): Advertises the public IP address (discovered via
STUN) for the contact address for signaling traffic.

None: Advertise the local IP address only for both signaling and media traffic.

Server address:

Empty: Discover the address of the firewall traversal server (the STUN or
TURN server), if available, using DNS SRV.

Specified: Use the firewall traversal server specified as either an IP address
or a fully qualified host name. If you use Auto-detect firewall traversal
method using ICE (Windows) or Auto-detect (ICE, recommended) (Mac),
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you can only enter a STUN server here. Do not enter a TURN server
because TURN is not supported when ICE is used.

User name: The user name for the server.

Password: The password for the server.

Port Ranges

Range of ports used for signaling (Windows) / Range of ports used on local computer
(Mac): Set the range of ports on the local computer for SIP signaling.

Selected: Your computer is behind a restrictive firewall that only allows
specific port ranges to be used. Enter the port ranges for your SIP account
and also open the same ports on your firewall. Refer to applicable firewall
documentation for more information.

Cleared: You computer is not behind a restrictive firewall.

Range of ports used for RTP: Set the range of ports on the local computer RTP audio
and RTP video.

Selected: Your computer is behind a restrictive firewall that only allows
specific port ranges to be used. Enter the port ranges for your SIP account
and also open the same ports on your firewall. Refer to applicable firewall
documentation for more information.

Cleared: You computer is not behind a restrictive firewall.

Custom DNS

Server 1 / Server 2: Enter the custom domain name server. A custom DNS is a domain
name server that is specific to a given domain (network or sub-network). It provides X-
Lite the ability to query inside the network for IP addresses associated to domain names
rather than querying outside the domain.

Presence panel (SIP)

Presence allows other softphone users to see your online status and allows you to see
the online status of others.
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This panel lets you configure how your SIP account handles online status for contacts
who have a softphone number. The Presence panel only appears if you have selected
IM / Presence in Allow this account for.

Settings in this panel:

Presence

Mode: Enter the value specified by your VoIP service provider.

Peer-to-peer

Presence agent

Poll time: The frequency, in seconds, that X-Lite uses to check presence.

Refresh interval: The amount of time, in seconds, that X-Lite refreshes your presence.

Transport settings (SIP)

You can configure the method X-Lite uses for transporting your SIP signal.

Settings in this panel

Transport

Signaling transport: Contact your VoIP service provider to identify the types of transport
that are supported.

Automatic: X-Lite sets up the transport based on the capabilities of the
network and the X-Lite computer. Choose this option if you do not care which
transport is used.

TCP (Transmission Control Protocol): This transport provides no signaling
security.

UDP (User Datagram Protocol): This transport provides no signaling
security.

TLS (Transport Layer Security): Choose this option to request signaling
encryption or both signaling and media encryption.
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Media Encryption (Windows) / Media Encryption over TLS (Mac)

Media Encryption (Windows) / Media Encryption over TLS (Mac): Applies when TLS is
chosen for transport. See Transport settings (SIP).

Security

Verify TLS Certificate: Applies when TLS is chosen for transport.

Selected: X-Lite attempts to verify one or more of the certificates sent by the
SIP server to see if it is trusted. If the certificate is trusted by a well-known
certificate authority such as VeriSign, no further action is required. If the
certificate is self-signed, install a corresponding CA certificate on your
device. Contact your VoIP service provider to get a corresponding CA
certificate.

Cleared: X-Lite accepts the certificate without trying to verify it.

IPv6: Generally, leave this selected. Clear the check box only if advised by your VoIP
service provider or your system administrator.

Selected: Allows X-Lite to make phone calls and send IMs over an IPv6
network.

Advanced settings (SIP)

The Advanced panel allows you to set registration intervals, timers, the hold method,
and mange connections.

Settings in the panel:

Register Settings

Reregister every: The time interval measured in seconds between X-Lite’s attempts to
reregister in order to refresh the account registration with the account’s VoIP service
provider. A value of zero means that X-Lite should not attempt to reregister after the
initial registration. This value is placed in the Expires header field of the REGISTER
message.

Minimum time: If the reregister fails, X-Lite waits this amount of time, measure in
seconds, and then attempts to reregister. If the second attempt fails, X-Lite waits twice
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this time and tries again. Each time the attempt to reregister fails, X-Lite increases the
amount of time between tries until registration succeeds.

Timers

Enable session timers: A session timer is a mechanism to detect whether a call session
still active from a signaling point of view. When the timer expires, a refresh is sent from
one party to the other. This timer is then reset.

Selected: Turns on the session timers.

Cleared: Turns off session timers, refreshes will never be sent.

Session time preference: Specifies how X-Lite uses session timers.

Inactive: Session timers are not used in any session, except when it is
explicitly required in the remote request.

Optional: Session timers are used in all sessions whenever the remote party
supports and uses it.

Required: Session timers support is a requirement for the remote party to be
able to establish a session.

Always: Sessions timers are used in all sessions whether or not the remote
party supports or uses it.

Default session time: The default value of the session timer measured in seconds.

Hold Method

Hold method: Change this setting only if your VoIP service provider advises you to.

Handle hold request in M-line only (latest standard)

Handle hold request in M-line and C-line (old standard)

Connection Management

Send SIP keep-alives: Typically selected. Instructs X-Lite to send SIP keep-alive
messages in order to maintain a “pinhole” through your firewall for SIP messaging.

Use rport: Typically selected.
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Use SIP Outbound: Determines X-Lite uses an existing connection.

Selected: X-Lite uses an existing connections by populating the SIP header
as specific to RFC 5626. The SIP server should communicate with X-Lite
using the same connection if the transport is set to TCP or TLS.

Cleared: X-Lite does not use an existing connection.

Force outbound proxy on all requests: Typically Cleared. Use this setting only if you
have trouble connecting to the SIP server.

Selected: Requests always go to the outbound proxy configured in Send
outbound via on the Account (Windows) or General (Mac) panel. X-Lite
never sends the invite directly to the end point. If you select this field, make
sure you also set Send outbound via.

Windows Outlook account settings
This section describes how to integrate Outlook contacts so they remain in sync.

Outlook account

The user can enable the Outlook account to provide X-Lite with access to the contacts in
their address book. The users can map contact addresses to fields in X-Lite in order to
make calls and send messages to Outlook contacts. Calls and messages can be made
either from X-Lite or from within Outlook.

Settings in the panel

Account

Protocol: Read only. Always specifies Outlook.

Account Details

Outlook profile: The default Outlook profile detected by X-Lite. If Outlook is set up with
more than one profile and you want to use a different profile other than the default, you
need to change the default profile in Outlook. After you configure the default profile in
Outlook, X-Lite detects the profile that you have change to.
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Field to use for Softphone address: If you are using SIP for presence, you can set up X-
Lite to treat one of the contact fields in Outlook as a SIP address that can be subscribed
to.

Softphone address example

If you select Business Telephone Number in this field, any values that
are in the Business Telephone Number field in Outlook are copied to
the Softphone field in X-Lite and X-Lite subscribes to the online status
of that contact through your SIP account. If an Outlook contact has
“2766” in Outlook’s Business Telephone Number field and your SIP
account domain is “domainA.com”, X-Lite subscribes to
“2766@domainA.com”.

Field to use for IM address: If you have an XMPP account, you can set up X-Lite to treat
one of the contact fields in Outlooks as an XMPP address that can be subscribed to.

IM address example

If you select IM Address in this field, any values that are in the IM
Address field in Outlook are copied to the Instant Message field in X-
Lite and X-Lite subscribes to the online status of that contact through
your XMPP account. If an Outlook contact has
“aphillips@acphone.com” in Outlook’s IM Address and the domain of
your XMPP account is acphone.com, X-Lite subscribes to
“aphillips@acphone.com”.

Configuring X-Lite – Preferences
There are two ways of configuring X-Lite – Account Settings and Preferences.

Account Settings are settings that only apply to an individual account.

Preferences are settings that let you control the way that you work in X-Lite.
Preferences also contains fields to configure features that apply globally rather than on
a per-account basis.
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This section describes Preferences.

For Windows, click Preferences on the Softphone menu. For Mac, click Preferences
from the X-Lite menu on the menu bar.

Preferences: Application panel
This panel lets you set preferences for the general user interface.

Settings in the panel:

General Preferences (Windows)

Language: The language you want the app to run in. Restart X-Lite for the change to
take effect. Supported languages are English (US), Dutch, French, German, Italian,
Japanese, Portuguese, Russian, Simplified Chinese, and Spanish.

Launch when Windows starts: Determines whether you need to start X-Lite manually.

Selected: X-Lite X-Lite launches when you start Windows.

Cleared: Start X-Lite manually.

Call immediately once a phone number is selected: Restart X-Lite for the change to
take effect.

Selected: You can start a X-Lite call without click the Make a call button.

Cleared: You must click the Make a call button to start a call.

Enable Sign In screen: Only available when you selected I will manually input my
account configuration on initial start up. Check if you have login credentials. Restart X-
Lite for the change to take effect.

Selected: The next time you start X-Lite, you will see the sign in screen.

Cleared: The next time you start X-Lite, you will not see the sign in screen.

Set X-Lite as your default softphone: This works for Windows 7 only. See Setting X-Lite
as your default softphone to set X-Lite as your default softphone in Windows 10.

Enable/Disable Outlook integration: See Office integration.
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General Preferences (Mac)

Pause iTunes when making or receiving calls:

Selected: X-Lite pauses iTunes when you are using X-Lite to place and
receive calls.

Cleared: X-Lite does not pause iTunes when you are using X-Lite to place
and receive calls.

Set X-Lite as your default softphone: Determines whether X-Lite is your default
softphone.

Selected: X-Lite is your default softphone.

Cleared: X-Lite is not your default softphone.

Call immediately once a phone number is selected: Restart X-Lite for the change to
take effect.

Selected: You can start a X-Lite call without click the Make a call button.

Cleared: You must click the Make a call button to start a call.

Enable Sign In screen: Only available when you selected I will manually input my
account configuration on initial start up. Check if you have login credentials. Restart X-
Lite for the change to take effect.

Selected: The next time you start X-Lite, you will see the sign in screen.

Cleared: The next time you start X-Lite, you will not see the sign in screen.

Messages & Presence

Display idle status if I don’t use my computer for:

Selected: X-Lite automatically changes your status to Idle if you have not
used your computer for a set amount of time.

Set the amount of time here. Time is measured in minutes.

In messaging, pressing Enter will: Set the action for pressing ENTER when you are
composing an IM.
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Send the message (Use SHIFT + ENTER to create a line) (Windows)

Create a new line (Use SHIFT+ ENTER to send) (Windows)

Send the message (Use CTRL+ ENTER to create a new line) (Mac)

Create a new line (Use CTRL+ ENTER to send) (Mac)

Show timestamp on messages: Changing this setting affects all messages in your
history.

Selected: X-Lite displays date and time information in the message.

Cleared: Cleared: X-Lite only displays the message content.

You can always hover over a message to get the date and time information.

Show hyperlink preview on messages: X-Lite can display a preview for any hyperlinks
that appear in Messages.

Selected: X-Lite shows a hyperlink preview in the message.

Cleared: Cleared: X-Lite does not show a hyperlink preview in the message.

Messaging Font Face: Use the drop-down box to select a different font for your
messages.

Messaging Font Size: Use the drop-down box to select a font size for your messages.

Default Actions

This section lets you configure the default action for the Call and Transfer buttons and
the action that occurs for double-clicking on a contact.

l You can set the action of the Call button to Call, Make a video call, or Start a
conference.

l You can set the action for double-clicking to Call, IM, or E-mail.

Button: Use the drop-down list to select the button you want to change the default action
for.

Call

Transfer
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Default Action: Use the drop-down list to set the action that occurs when you single-click
on the Call or Transfer button.

Call

Make a video call

Start a conference

Call First

Transfer Now

Action when double-clicking on contact: Use the drop-down list to set the action that
occurs when you double-click on a contact.

Call

IM

E-mail

Preferences: Alerts and sounds panel
This panel lets you change the way you are notified of calls, IMs, and messages.

For information on the device that X-Lite uses for ringing, incoming audio, and incoming
video, see Preferences: Devices panel.

Enabling alerts

You can set up X-Lite to send an alert for incoming calls, contacts going online or offline,
and incoming IMs. Select Enable alert displays to enable alerts for all the actions. Once
Enable alert displays is selected, you can select whether you would like to receive an
alert for each event.

For Windows 10, see Configuring desktop notifications to make sure system notifications
are enabled.

Windows

In Windows, you will receive an notification from X-Lite. If you are running Windows 10,
you may receive a Windows 10 interactive toast notification or a Windows 7 style
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notification. The Windows 10 interactive toast notification is sent when you select Use
Windows notifications in Preferences > Alerts & Sounds .

Windows 7 style notification

A X-Lite alert allows you to answer a call, answer a call with video (if the remote party
initiated a video call), or decline a call.

Windows 10 interactive toast notifications

With an interactive toast notification, you can answer or decline the call, or you can
decline the call and send an IM to the remote party. The incoming call notification
displays the name of the remote party and the number they are calling from. If you have
more than one SIP account, the notification also displays the account that the call is
received on.

Mac

X-Lite uses OS notifications. Make sure that the notifications are set up for X-Lite in the
Mac system preferences.

Setting up OS notifications

1. From the menu, click the Apple logo and click System Preferences >
Notifications.

2. Click X-Lite.

3. Choose the banner or alert notification style.

You will receive either a banner or alert notification when you have an incoming call or
instant message on X-Lite. Banner style notifications appear briefly in the top corner of
the screen. They will disappear on their own. Alert styles notifications appear and
remain on the screen until you take action on them.
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Banner and alert notifications

If you receive a banner notification, you can click on the notification to open the call
panel or the Messages window.

If you receive an alert style notification for a phone call, you can click Answer or Decline
on the notification or click anywhere else on the notification to open the call panel.

If you receive an alert style notification for an IM, you can click Close or click anywhere
else on the notification to open the Messages window.

Enabling sounds

You can set X-Lite up to play a sound in the following events:

l For an incoming call

l For call waiting

l For auto answer

l For hangup

l For an incoming IM

l When a contact comes online

l When a contact goes offline

Select Enable sounds to turn on sounds for all the actions. Once Enable sounds is
enabled, you can select whether you would like to hear a sound for each event.

You can assign a sound for each event. Click on the event you want to change the alert
sound for. Use Browse to locate the file you want to use.

Settings in the panel

Alerts

Enable alert displays: Determines if X-Lite displays notifications. Once Enable alert
display is selected, you can select whether you receive an alert For an incoming call,
When a contact comes online, When a contact goes offline, or For IMs (show alert
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instead of automatically opening the IM window) by selected or clearing the
corresponding box.

Selected: You can set up alerts for incoming calls, contact presence, and
IMs.

Cleared: X-Lite flashes in the taskbar (Windows) or the Dock (Mac) for
incoming calls, contact presence changes, and IMs.

Windows 10 only: A X-Lite sends a Windows 7 style notification or a Windows
interactive toast notification.

Use Windows notifications (Windows only): Determines whether X-Lite sends Windows
7 style notifications or Windows 10 interactive toast notifications.

Selected: X-Lite sends Windows 10 interactive toast notifications.

Cleared: X-Lite sends Windows 7 style notifications.

Sounds

Enable sounds: Determines if X-Lite plays sounds for notifications. Once Enable Sounds
is selected, you can select whether a sound is played For an incoming call, For call
waiting, For auto answer, For hangup, For an incoming IM, When a contact comes
online or When a contact goes offline by selected or clearing the corresponding box.

Selected: You can set up X-Lite to play sounds for calls, contact presence,
and IMs.

Cleared: X-Lite flashes in the taskbar (Windows) or the Dock (Mac).

Windows 10 only: A X-Lite sends a Windows 7 style notification or a Windows
interactive toast notification.

Sound preference: If you have enabled sounds for an event, you can select the
individual event and choose a sound to play for that event.

Click Browse and find the file locations for the sound you want to use.

Click Reset to go back to the default sound.
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Preferences: Devices panel
This panel lets you select your Speaker and Microphone in Headset Mode and in
Speakerphone Mode, and lets you select which device should ring, your Camera, and
the maximum resolution for video.

Unless you have made changes in Devices, X-Lite automatically detects devices at
each startup and selects the most appropriate device for audio and video. Your choices
apply at the next start up unless the device is no longer in use, in which case, X-Lite will
automatically detect the device to use.

On a new install, X-Lite uses your system default device for the speaker and the
microphone.

Test Devices: Opens the Troubleshooting window.

Test Camera: Opens the Video window and shows the image from your camera.

Headset Mode

Change these fields only if you want to override the devices that X-Lite automatically
selected.

Speaker: Click the drop-down arrow to see the devices detected by X-Lite. Select the
device you want to use for the speaker when you are using a headset.

Microphone: Click the drop-down arrow to see the devices detected by X-Lite. Select the
device you want to use for the microphone when you are using a headset.

Speakerphone Mode

Change these fields only if you want to override the devices that X-Lite automatically
selected.

Speaker: Click the drop-down arrow to see the devices detected by X-Lite. Select the
device you want to use for the speaker when you are in speakerphone mode.

Microphone: Click the drop-down arrow to see the devices detected by X-Lite. Select the
device you want to use for the microphone when you are in speakerphone mode.

Reduce echoes from speakers (AEC): Automatic echo cancellation.

CounterPath Corporation 121

X-Lite User Guide Configuring X-Lite



Selected: Improves the sound quality. The feature is typically on.

Other Devices

Ring on: Change this field only if you want to override the devices that X-Lite
automatically selected.

Click the drop-down arrow to see the devices detected by X-Lite. Select the device
where you want to hear the phone ringing.

Camera: Change this field only if you want to override the devices that X-Lite
automatically selected.

Click the drop-down arrow to see the devices detected by X-Lite. Select the device you
want to use as your video camera.

Max Resolution: Click the drop-down arrow and select the maximum resolution you
want to user for your outgoing video.

Low (CIF): Common Intermediate Format, uses 352 x 240 pixels.

Medium (VGA): Video graphics array, uses 640 x 480 pixels.

Preferences: Shortcut keys panel (Windows)
X-Lite supports system-wide shortcut keys and keyboard accelerators. This topic
describes how to enable shortcut keys. For keyboard accelerators, see X-Lite Desktop
keyboard accelerators.

l Shortcut keys work regardless of whether X-Lite is in focus or not. Other
applications on your device may interfere with these operations. X-Lite shortcut
keys are disabled by default until you enable them under Preferences.

l Keyboard accelerators apply only when X-Lite is in focus. They are keyboard
combinations that speed up common interactions with X-Lite. They cannot be
enabled/disabled, or customized.

System-wide shortcut keys

Answer call CTRL+SHIFT+ALT+A
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Hang up call CTRL+SHIFT+ALT+H

Focus on X-Lite CTRL+SHIFT+ALT+F

Toggle mute CTRL+SHIFT+ALT+M

Redial CTRL+SHIFT+ALT+R

Dial selected text CTRL+SHIFT+ALT+D

Focus on Joined Screen Share CTRL+SHIFT+ALT+S

On the Shortcut keys panel of the Preferences window, select Enable shortcut keys to
use the shortcuts in X-Lite. You can also enable or disable individual shortcut keys by
selecting or clearing Enable for each action.

To customize shortcut key combinations

You can change the default shortcut key combinations.

1. Make sure Enable shortcut keys is selected and the action you want to change is
enabled.

2. Select an Action and click Edit. The Edit Shortcut Key window opens.

3. Select the keys that you want to use in the new combination. Select at least two
keys.

4. Type the desired letter or number in the field.

5. Click Assign.

You can use the new shortcut key combination for the action you selected.

Shortcut key combination rules

The following rules apply to shortcut key combinations.

l You cannot override a standard Microsoft Windows combination such as
CTRL+ALT+DELETE.

l The shortcut applies when X-Lite is running, regardless of the application that is in
focus.

l If another program uses the same shortcut key combination, the application that
was started later has control over that combination.
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l If a shortcut key combination is not valid at a particular moment, entering the
combination has no effect. For example, CTRL+SHIFT+ALT+A has no effect if
there is no incoming call on X-Lite.

Preferences: Audio codecs panel
Audio codecs describe the format by which audio streams are compressed for
transmission over networks. Each codec has different characteristics and each works
better in some situations that others.

Codecs can be categorized as either narrowband, wideband, or super-wideband, and
fixed bit rate or variable bit rate.

l Narrowband codecs work with low bandwidth, such as a dial-up Internet
connection. These codecs have a sampling rate of 8 kHz.

l Wideband codecs work with high bandwidth and result in better audio quality.
Wideband codecs do not work with PSTN numbers. These codecs have a
sampling rate of 16 kHz.

l Super-wideband codecs have a sampling rate of 24-48 kHz.

l Fixed bit rate codecs use the same amount of data during the call.

l Variable bit rate codecs use different amounts of data depending on network
conditions.

This panel shows all of the codecs that are included in your version of X-Lite. You can
enable and disable codecs by clicking on the codec and clicking one of the arrow
buttons to move it between the Available Codecs column to the Enabled Codecs
column. You can also view the codec properties by clicking on each codec.

With only one codec enabled, all calls will use that codec. With more than one codec
enabled, X-Lite offers the enabled codecs and negotiates a common codec with the
other party.

You cannot change the properties of any codecs.

Enable RFC 7261 negotiation: Without this option selected, X-Lite responds with G.729
annexb=y to an incoming invite with G.729 annexb=no. If calls negotiated with the G.729
codec fail, select this option.
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Preferences: Video codecs
Video codecs describe the format by which video streams are compressed for
transmission over networks. Some codecs require less bandwidth than others but may
result in lower video quality.

This panel shows all of the codecs that are included in your version of X-Lite. You can
enable and disable codecs by clicking on the codec and clicking one of the arrow
buttons to move it between the Available Codecs column to the Enabled Codecs
column. You can also view the codec properties by clicking on each codec.

With only one codec enabled, all calls will use that codec. With more than one codec
enabled, X-Lite offers the enabled codecs and negotiates a common codec with the
other SIP client. If you do not have a common codec with the other party, video will not
be available on the call.

Preferences: Calls
This panel allows you to configure DTMF.

DTMF

Select a method X-Lite uses when using dual-tone multi frequency (DTMF) or interactive
voice response.

You may need to change this method if you cannot interact with interactive voice
response systems — auto attendants, voice-activated menus. Contact your VoIP service
provider or your system administrator for the correct setting.

l Send via RFC 2833

l Send via INFO

l Send in-band

l RFC 2833 and SIP INFO

l In-band and SIP INFO

In-band means that X-Lite encodes DTMF signals in the audio stream as regular sound.
Typically, DTMF is not send in-band.

You may want to use in-band if all three conditions apply:
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l You own your own gateway.

l One or more gateways do not support RFC 2833 or do not handle it well.

l Your gateway is using codes that reproduce DTMF codes well.

In this case, sending in-band ensures your DTMF tones get through because they
bypass the gateway and they are reproduced accurately on the receiving end.

Play DTMF tones back to me

Selected: X-Lite plays key tones through your speaker when you dial.

Cleared: X-Lite does not play key tones.
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Reference

This section provides reference information regarding X-Lite.

Troubleshooting
On the Help menu, click Troubleshooting to display the Troubleshooting window.

Devices panel
You can verify that your microphone and speakers are working and can set the volume
to a comfortable level without having to place a call.

1. Select the microphone and speakers that you want to use from the drop-down
menus.

2. Speak into the microphone. If X-Lite detects sounds, you see Your microphone
works.

3. Click the Play button while listening to the speakers. Drag the volume slider to set
the volume to a comfortable level. If your speakers are working, you see Your
speakers work.

Audio panel
While you are on a phone call, you can test the quality of the audio.

Note: To perform a valid test, you should be on an established call and not on a call attempt.

Video panel
While you are on a video call, you can test the quality of the video.

Note: To perform a valid test, you should be on an established call and not on a call attempt.
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Support panel
If you have contacted CounterPath Customer Support in order to troubleshoot a problem,
you may have been asked to generate a diagnostic log and send it to CounterPath.

To send a log

1. On the Help menu, click Troubleshooting. The Troubleshooting window opens.

2. On the Support tab, change the log level to Verbose by moving the slider next to
View Log (Windows) or View Current Log (Mac).

3. Close the Troubleshooting window.

4. Reproduce the problem you were having.

5. Return to the Support tab in Help > Troubleshooting.

6. Click Send log. The Send Log Report window opens.

7. Type a brief description of the problem you were having and click Send Log
(Windows) or Send Log Report.

X-Lite sends the log to CounterPath.

To view a log

1. On the Help menu, click Troubleshooting. The Troubleshooting window opens.

2. On the Support tab, click View Log (Windows) or View Current Log (Mac).

CounterPath displays the reference number of previous logs. You cannot view the
previous logs but the reference number could be helpful when you are talking to
customer support. The customer support representative can view the previous logs and
can use the reference number to find the correct log.

X-Lite Desktop keyboard accelerators
Keyboard accelerators apply only when X-Lite is in focus. They are keyboard
combinations that speed up common interactions with X-Lite. They cannot be
enabled/disabled, or customized. They are different from system-wide shortcut keys that
can be customized in Windows.
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Windows

Making or answering a call

CTRL+N: Answer an incoming call

CTRL+D: Decline an incoming call

CTRL+R: Redial the last number called

CTRL+R then ENTER: Redial the last number called

CTRL+E: End a call or end a conference call (hang up on all participants).

During a call

CTRL+M: Mute your voice

CTRL+H: Hold or resume a call when the focus is on the call panel

CTRL+T: Transfer an established call when the focus is on the call panel

↑ (Up arrow): Turn the call volume up when the focus is on the call panel

↓ Down arrow: Turn the call volume down when the focus is on the call panel

F11: Display the Video window in full screen when the focus is on the Video windows

During a screen share session

SHIFT+CTRL+ALT+S: Bring the screen share window to the front and in focus

Opening a window

SHIFT+CTRL+M: pen the Messages window

F8: Open the Preferences window

CTRL+F9: Open the Support tab in the Troubleshooting window

F1: Open Help in a browser

Exiting

CTRL+Q: Quit X-Lite.

CounterPath Corporation 129

X-Lite User Guide Reference



Mac

Making or answering a call

CTRL+N: Answer an incoming call

CTRL+D: Decline an incoming call

CTRL+R: Redial the last number called

CTRL+R then ENTER: Redial the last number called

CTRL+E: End a call or end a conference call (hang up on all participants).

During a call

CTRL+M: Mute your voice

CTRL+H: Hold or resume a call when the focus is on the call panel

CTRL+T: Transfer an established call when the focus is on the call panel

↑ (Up arrow): Turn the call volume up when the focus is on the call panel

↓ (Down arrow): Turn the call volume down when the focus is on the call panel

Opening a window

SHIFT+COMMAND+M: Open the Messages window

COMMAND+,: Open the Preferences window

CTRL+F9: Open the Support tab in the Troubleshooting window

SHIFT+COMMAND+V: Open the Video window

SHIFT+COMMAND+?: Open Help in a browser

Exiting

COMMAND+Q: Quit X-Lite.
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